# Baylor Law Technology Guide

## Table of Contents

- Contact Information ............................................................................................................................... 1
- Wi-Fi ...................................................................................................................................................... 1
- Laptop Setup Instructions.................................................................................................................. 1
  - Windows 10 ..................................................................................................................................... 1
  - Mac OSX ......................................................................................................................................... 2
- Mobile Device ..................................................................................................................................... 2
  - Android OS ..................................................................................................................................... 2
  - Apple iOS ........................................................................................................................................ 2
- Troubleshooting .................................................................................................................................. 3
- Printing .................................................................................................................................................. 3
  - Installing PawPrints .......................................................................................................................... 4
  - Using Paw Prints................................................................................................................................ 5
  - Allotment Increases ............................................................................................................................ 5
  - LEXIS Printing................................................................................................................................... 5
  - West Law ............................................................................................................................................ 5
  - Map of Printers................................................................................................................................... 6
- Exam Software ....................................................................................................................................... 7
  - Respondus LockDown ......................................................................................................................... 7
  - Exam 4 ................................................................................................................................................ 7
- Writing Applications .............................................................................................................................. 8
  - Adobe Acrobat ..................................................................................................................................... 8
  - BriefCatch .......................................................................................................................................... 8
  - Grammarly ......................................................................................................................................... 9
- Microsoft Word ....................................................................................................................................... 9
  - Section Breaks .................................................................................................................................... 9
  - Restarting Page Numbering ............................................................................................................. 10
  - Deleting Section Breaks ................................................................................................................... 10
  - Removing Metadata ........................................................................................................................... 11
    - Windows 10 ................................................................................................................................... 11
    - Mac OSX ....................................................................................................................................... 11
  - Frequently Used Shortcuts .............................................................................................................. 12
CONTACT INFORMATION

IT Staff is available to assist you with both personal and school related technology issues and to check-out technology, such as iPads and laptops. The IT Offices are located on the third floor of the library next to the elevator. The Baylor Law IT Help Desk is located outside the IT Offices in the third-floor computer lab and is open during library hours.

Rick Sowell
Director of Information Technology
254-710-4723
Ricky_Sowell@baylor.edu

Ricky Lovecky Senior
Systems Programmer
254-710-2011
Ricky_Lovecky@baylor.edu

Chris Griesemer
Senior Information Technology Associate
254-710-4596
Chris_Griesemer@baylor.edu

Baylor Law IT Help Desk
254-710-4695

For the quickest contact with the entire Information Technology Team, please send an email to us at baylorlawIT@baylor.edu.

WI-FI

The AirBear wireless network (AIRBEAR WPA2) connects and empowers the Baylor University community.

LAPTOP SETUP INSTRUCTIONS

WINDOWS 10

1. Click on the wireless icon on the bottom right of the screen and select "AIRBEAR WPA2"
2. Enter your Bear_ID and Password and click OK
3. Click Connect on the next screen to finish the process
4. You should now be connected

https://www.baylor.edu/its/index.php?id=925237
MAC OS X
1. Select the AirPort icon at the top of the MacOS X desktop, and select "AIRBEAR WPA2"
   a. 
2. Enter your Bear_ID and Password
3. When the "Certificate" dialog box pops up, click Continue
4. If prompted, enter your computer password (NOT your Baylor password) and click Update Settings
   a. 
5. After a few seconds, you should be connected.

https://www.baylor.edu/its/index.php?id=76615

MOBILE DEVICE
ANDROID OS
1. Go to settings
2. Tap on Wi-Fi
3. Make sure Wi-Fi is turned on, then tap on AIRBEAR WPA2.
   a. For the CA Certificate, you may need to set it to “Do Not Validate”
4. Enter your Bear ID for Identity, then enter your password.


APPLE IOS
1. Select the Wi-Fi menu from the Settings app.
2. Select AIRBEAR WPA2 from the network list.
3. Enter your Bear ID and Password. Click Join.
4. Press Accept to verify the certificate. You should now be connected.

https://www.baylor.edu/its/index.php?id=84031
TROUBLESHOOTING

Q I changed my Bear ID password and now I cannot access the AirBear Wireless Network.
A. You will need to update your password in your computer's Wi-Fi settings.

On Mac OS X, you will need to delete the AIRBEAR WPA2 profile under Preferred Networks (Network Preferences-->Advanced-->Select AIRBEAR WPA2 in the network list and click the "-" button), then turn the Wi-Fi Off and then back On. Then, reconnect to AIRBEAR WPA2.

On a Windows laptop, it should ask you for the new password after a few failed attempts.

Q The wireless connection on my Mac keeps disconnecting
A. You will need to delete the AIRBEAR WPA2 profile under Preferred Networks (Network Preferences-->Advanced-->Select AIRBEAR WPA2 in the network list and click the "-" button), then turn the Wi-Fi Off and then back On. Then reconnect to AIRBEAR WPA2.

Q My Windows laptop will not ask for my username and password. The computer says "Cannot Connect"
A. This is usually caused by an antivirus or firewall program that is interfering with communication to the authentication server. Normally this can be corrected by removing third party antivirus and firewall software and use Microsoft Defender and the firewall built into Microsoft Windows.

Q My computer (PC or Mac) will not let me login to AIRBEAR WPA2. It keeps failing.
A. Make sure your computer's clock is set correctly. In order to properly authenticate on the AirBear Wireless Network, the clock on your device must closely coincide with the current time on the network.

Q My Windows laptop will not stay connected to AirBear
A. Check to make sure the wireless drivers are up-to-date.

https://www.baylor.edu/its/index.php?id=925240

PRINTING

Instead of installing dozens of campus printers, Baylor uses PawPrints that are linked to all printers on Baylor's campus. There are two versions of PawPrints: PawPrints and PawPrints_Law. PawPrints is used on the main campus, and PawPrints_Law is used at the law school. When you're ready to print, choose PawPrints_Law if printing at the law school or select any of the other four PawPrints queues for non-law school locations on campus.
and then use your computer browser to choose the destination printer. Mobile Release will store your jobs for 24 hours, so you can submit your jobs now and pick them up on any printer at your convenience throughout the day.

Students are charged different amounts depending on whether they print to main campus printers or law school printers. Be aware that printing anywhere other than the law school will be at least 3 times more expensive than printing in the law school. The charge is

- $0.02 B&W & $0.08 Color if printing to Law Printers
- $0.07 B&W & $0.28 Color if printing to non-Law Printers

Regardless, the 50% duplex discount allows every other page of a print job to be free.

Students are not charged real money for printing. Each Law Student PawPrints account will be credited $30 (1,500 B&W or 375 Color).

The following groups will receive additional pages:

- PC Students $18 (900 pages B&W or 225 color)
- Teams $6 (300 pages B&W or 75 Color)
- Assistants $6 (300 pages B&W or 75 Color)
- MBA $25 (1,250 pages B&W or 312 Color)

User balances can accumulate to a max of $85 (the total of all possible adjustments per quarter). $85 equates to 4,250 pages B&W or 1,062 Color.

**INSTALLING PAWPRINTS**

This is a two-step process. First, you will install PawPrints and then you will install the PawPrints_Law printer.

**Step 1:** First, install PawPrints.

Users must install Pawprints before first use. Installation includes:

1. All 4 PawPrints queues:
   a. PawPrints_1sided
   b. PawPrints_2sided
   c. PawPrintsColor_1sided
   d. PawPrintsColor_2sided
2. Pawprints App for account details, print job authentication for personal computers, and easy access to release page, print history, and refunds.

**Step 2:** Second, to install the Law School print queue, PawPrints_Law, select the correct installer for your operating system.

https://www.baylor.edu/law/index.php?id=950280

**USING PAW PRINTS**

1. Go the printer page on your document.
2. Choose PawPrints_Law as the printer.
3. Adjust your print settings.
4. Go to PawPrints Mobile Release
   a. [https://print.baylor.edu:9192/mobile/release](https://print.baylor.edu:9192/mobile/release)
5. Select Printers
6. Choose the Printer you wish to print to

**ALLOTMENT INCREASES**

Students requesting additional pages will be required to complete a process that begins by filling out an increase request form and meeting with a Law IT staff member. Requests for increase will be awarded if approved within two business days of completing the process. Students must be at or below a $1.00 balance before their request form is accepted. When Law Students PawPrints account reaches $0, they will not be able to print for at least two business days.

Form:
[https://forms.office.com/Pages/ResponsePage.aspx?id=NfvSImolm0W89Nwj1C3ApACHluJWFH9AkHGuudGr4BFUNEpBMTNDN1RNS1cwMjVBNURCVEZYVIE1QSQIQC0NPWcu](https://forms.office.com/Pages/ResponsePage.aspx?id=NfvSImolm0W89Nwj1C3ApACHluJWFH9AkHGuudGr4BFUNEpBMTNDN1RNS1cwMjVBNURCVEZYVIE1QSQIQC0NPWcu)

**LEXIS PRINTING**

LEXIS NEXIS offers free printing. To use the LEXIS printers, print from LEXIS rather than using PawPrints.

1. Select the printer icon at the top right of the page.
2. Select the LEXIS printer you wish to print to from the drop down
3. Adjust your print settings
4. Click “Print”

**WEST LAW**

West Law does not offer printing services. To print from West Law, download the document and print using PawPrints.
MAP OF PRINTERS
First Floor

1. Student Lounge A
2. Student Lounge B
3. Student Lounge Color
4. Law Circulation A
5. Law Circulation B
6. Law Circulation Color
7. Law Reserve
8. LEXIS Student Lounge
9. LEXIS Library Lobby
10. LEXIS Computer Lab

Second Floor

11. Law Second Floor Copy Room A
12. Law 2nd Lockers B
13. LEXIS PC Locker Room 235
14. Law Computer Lab
15. LEXIS Library 3rd Floor

EXAM SOFTWARE

RESPONDUS LOCKDOWN
If any of your instructors administer an exam in Canvas, you will use Lockdown Browser and Respondus Monitor.

Download the software at
http://www.respondus.com/lockdown/download.php?id=755512061

Then, take at least one practice quiz: https://baylor.instructure.com/courses/115609/quizzes

EXAM 4
Below are the instructions to download and test the Exam4 software.

1. Go to https://www.exam4.com/
2. Click “Law Schools”
3. Click “T”
4. Click “Baylor University School of Law”
5. Register to download Exam4 by filling in the requested information.
6. Click “Download Exam4”
7. Follow the instructions on the set-up pop up.
8. Connect to the internet (Exam4 will submit both on and off campus if you have an
internet connection).
9. Take a practice exam on your own laptop using your currently assigned exam number to check the software (choose “Practice Exam” in CLOSED mode to practice on and submit it).

**WRITING APPLICATIONS**

**ADOBE ACROBAT**
Adobe Acrobat and the corresponding Creative Cloud Suite it belongs to is available on all lab machines in the building. Open Adobe Acrobat and log in with your Baylor email. Choose “Company or School Account” if prompted.

**BRIEFCATCH**
BriefCatch is a Word plug-in that offers editing suggestions that you can implement in real time. The program not only catches common mistakes but spots editing and advocacy opportunities that many lawyers and other writers miss. After each suggestion, just click “Change” or “Ignore.” You can also get feedback on the readability and flow of your entire document, and you can even generate a tailored custom report. If you make some of the suggested edits, your writing will be more concise, polished, and convincing. And you’ll save time.

*BriefCatch currently only works with the Windows version of Microsoft office.*

BriefCatch is available on all lab machines. Also, students with a Windows version of Microsoft Office can install BriefCatch onto their personal computers.

Installation instructions and links can be accessed here by providing your Bear ID and password: https://www.baylor.edu/law/index.php?id=959263.

1. Make Sure Microsoft Word is closed
2. Download the BriefCatchSetup.msi
3. Download the license.key file
4. Go to your Downloads folder and double-click BriefCatchSetup.msi
5. BriefCatch will install but it will not tell you that installation is complete.
6. Open Microsoft Word
   a. The first time you open Word, you may be prompted to confirm the installation. If so, click the Install button.
7. Click on the BriefCatch tab across the top
8. Click the About button
9. Click Install License
10. Browse to your Downloads folder and locate the file you downloaded in step 4 called license.key
11. Click **OK** on the message "Your license was successfully imported"
12. Click **OK** on the About Window
13. **BriefCatch** is now installed and licensed.

**GRAMMARLY**
The premium version is available to all law students. Be sure you are logged out of any personal Grammarly accounts. It is also highly recommended that you use a unique password as it is **NOT** connected to your BearID. The following are instructions on how to install it on your computer:

2. Provide your name, @baylor.edu email, and password
3. Check your inbox for the email and click on the activation link
4. Apply the access code ojOSWgVSMnBatvMz

**MICROSOFT WORD**
The IT Staff is happy to help with troubleshooting and formatting. Here are walkthroughs for common issues we have seen in the past.

**SECTION BREAKS**
1. Select where you want a new section to begin.
2. Go to Layout > Breaks.
3. Choose the type of section break you want:
   a. **Next Page** – Section break starts the new section on the following page.
   b. **Continuous** – Section break starts the new section on the same page. This type of section break is often used to change the number of columns without starting a new page.
   c. **Even Page** – Section break starts a new section on the next even-numbered page.
   d. **Odd Page** – Section break starts a new section on the next odd-numbered page.
**RESTARTING PAGE NUMBERING**

1. Go to Insert > Page Number and select the desired page number.
2. Select where you want the new section to begin.
3. Create a section break starting on the next page.
4. Go to the page number below the section break and click on the page number in the footer. This will pull up the Header & Footer tab.
5. In the “Navigation” section of this tab, you will see a highlighted button labeled “Link to Previous.” Click the "Link to Previous" button to UNSELECT it.
6. Next, go to page number > Format Page Number.
7. Select the appropriate number format and whether to continue the page numbering from the previous section or to start at "1" or another number.

![Page Number Format](image)

**DELETING SECTION BREAKS**

1. Go to the Home tab and select the paragraph symbol. This will allow you to see the section breaks.
2. Go to the section break you want to remove.
3. Click on the right side of the section break.
4. Hold down shift and press the right arrow key.
5. Press delete or backspace.
REMOVING METADATA
Removing metadata is an important step to prevent the unintentional discovery of work product. Because of this, you must remove metadata before submitting assignments during your time at Baylor Law.

WINDOWS 10
1. Click the File tab, and then click Info.
2. Click Check for Issues, and then click Inspect Document.
3. In the Document Inspector dialog box, select the check boxes to choose the types of hidden content that you want to be inspected. If your document has a header or footnotes, be sure to uncheck headers, footers, and watermarks.
4. Click Inspect.
5. Review the results of the inspection in the Document Inspector dialog box.
6. Click Remove All next to the inspection results for the types of hidden content that you want to remove from your document.

MAC OSX
1. Click on the “Tools” menu and select the “Protect Document” option
2. In the “Protect Document” window check the box next to “Remove personal information from this file on save”
3. Finish working on your document and then save.
4. Once you have saved the file and this setting has been activated the file will no longer have any identifiable information associated with it.
# Frequently Used Shortcuts

<table>
<thead>
<tr>
<th>To Do This</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open a document.</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Create a new document.</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Save the document.</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Close the document.</td>
<td>Ctrl+W</td>
</tr>
<tr>
<td>Cut the selected content to the Clipboard.</td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Copy the selected content to the Clipboard.</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Paste the contents of the Clipboard.</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Select all document content.</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Apply bold formatting to text.</td>
<td>Ctrl+B</td>
</tr>
<tr>
<td>Apply italic formatting to text.</td>
<td>Ctrl+I</td>
</tr>
<tr>
<td>Apply underline formatting to text.</td>
<td>Ctrl+U</td>
</tr>
<tr>
<td>Decrease the font size by 1 point.</td>
<td>Ctrl+[</td>
</tr>
<tr>
<td>Increase the font size by 1 point.</td>
<td>Ctrl+]</td>
</tr>
<tr>
<td>Center the text.</td>
<td>Ctrl+E</td>
</tr>
<tr>
<td>Align the text to the left.</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>Align the text to the right.</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td>Undo the previous action.</td>
<td>Ctrl+Z</td>
</tr>
<tr>
<td>Redo the previous action, if possible.</td>
<td>Ctrl+Y</td>
</tr>
<tr>
<td>Page Break</td>
<td>Ctrl+Enter</td>
</tr>
<tr>
<td>Open Find Box</td>
<td>Ctrl+F</td>
</tr>
<tr>
<td>Open Print Window</td>
<td>Ctrl+P</td>
</tr>
<tr>
<td>Create a Hanging Indent</td>
<td>Ctrl+T</td>
</tr>
<tr>
<td>Sets the selected text to all capital letters.</td>
<td>Ctrl+Shift+A</td>
</tr>
<tr>
<td>Adds double underline to the selected text.</td>
<td>Ctrl+Shift+D</td>
</tr>
<tr>
<td>Changes text to heading 1.</td>
<td>Ctrl+Alt+1</td>
</tr>
<tr>
<td>Changes text to heading 2.</td>
<td>Ctrl+Alt+2</td>
</tr>
<tr>
<td>Changes text to heading 3.</td>
<td>Ctrl+Alt+3</td>
</tr>
</tbody>
</table>